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Government Approvals
Canada Revenue Agency and the relevant provincial ministries (Alberta Treasury Board and Revenue Quebec) 
have approved the format and bar code format only of TaxTron pages for submission of tax returns in “pre-
scribed form.” You must follow proper procedures and guidelines when preparing and assembling a return.

Canada Revenue Agency and Revenue Quebec have certified TaxTron Individual and the Canada Revenue 
Agency has certified TaxTron Corporate for use in electronic filing of tax returns (EFile, NetFile,and TP1 Internet, 
and Corporate Internet Filing).

These approvals are reissued on a periodic basis, and carry a limited period of certification. Before use you 
should verify that the copy you are using is appropriate to the year or fiscal year of your return.

Disclaimer
You are now the owner of a sophisticated software package that simplifies the task of preparing your Canadian 
income tax returns. To use TaxTron successfully, you need to:

•	 know how to operate the computer itself
•	 have a reasonable understanding of income tax return preparation
•	 have access to Canada Revenue Agency and Revenue Quebec tax guides

TaxTron accurately models the calculations of income tax returns. To develop a valid return, you must enter 
information correctly in TaxTron dialogues and forms. If you are a new user, we recommend that you verify the 
calculations to understand how TaxTron operates and become confident that the auto- matic calculation fea-
tures of the program are satisfactory.

Any claims made in filing federal or provincial returns using TaxTron remain entirely the responsibility of the 
person filing the income tax return.



6

Welcome to 
TaxTron is a powerful program that simplifies preparing Canadian income tax returns. Use TaxTron to prepare 
single or linked spousal returns or federal/provincial returns, tailored for residents in any prov- ince or territory. 
You can even model different tax scenarios to determine how to maximize income tax savings.

TaxTron provides software in personal and professional editions for both Macintosh and Windows computers. 
All our software is fully bilingual in English and French.

To complete a TaxTron return, you enter taxpayer information into easy-to-use dialogues and pages that look 
like the actual tax forms. TaxTron takes care of all the calculations and transferal of data to the appropriate lines. 
When you are ready to submit a return, TaxTron prepares an electronic copy for NetFile submission or prints the 
package for paper delivery — complete with all necessary schedules and forms — in government-approved 
format and sequence.

What’s Included

Every TaxTron package is provided as a downloadable file or is shipped on CD-ROM. The contents will differ 
depending on which of the packages you purchased. Please read the license agreement before use.

TaxTron provides software for the preparation of Canadian individual tax returns, the T1 and TP1, as well as 
Canadian corporate tax returns, the T2. Personal editions as well as professional editions are supplied. The con-
tents of each package differ but the operation, look and feel of the software are essentially identical.

Registering With TaxTron

Prior to being able to print or to file any tax returns you will be required to activate your usage of the product. 
Returns may be prepared and saved prior to activation but cannot be prepared for transmission without activa-
tion.

Activation may be done in one of several ways: on a prompt on first starting the program; using the command 
in the Tools menu of the package; or on being prompted prior to printing or NetFiling a return. Users of the 
personal editions are required to enter a license number before activation can be completed.

Depending on the product and the size of a tax return you may also be required to register a license against a 
return. Licenses are required for any return prepared with the Corporate Mini and LE editions, and are required 
for all personal tax returns with income in excess of $30,000.

Registering a license for a return, “consumes” one license, reducing the number of available licenses you have 
purchased.

Registering a license can be done using the Registration command in the Tools menu, or when prompted prior 
to first printing or preparing a NetFile version of the return. Once registered, the return can be printed or pre-
pared for NetFile as many times as you require. Once registered you can also prepare both federal and Quebec 
versions of the return without further licensing.

In addition, CRA imposes a limit on the number of returns that can be prepared with the personal edition of 
the T1 product. No more than 20 returns can be prepared using any one installed copy of the software. This 
limit is enforced by TaxTron. You can view your consumption of this limit using the “License usage” command 
in the Tools menu. If you attempt to exceed this limit, you will be notified when trying to print or NetFile the 
return. This is not a limit on the number of returns you can prepare: just on the number of returns prepared for 
transmission.
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TaxTron Assistance

TaxTron offers full bilingual technical support by both phone and email throughout the year, on all our prod-
ucts. You can reach us by phone at (416) 491-0333, or by email at support@taxtron.ca.

The TaxTron Family

For individual returns, T1 and TP1:

TaxTron Personal Macintosh and Windows, approved each year for paper and Net-
File usage.

TaxTron Professional Macintosh and Windows, approved each year for paper and Net-
File usage.

On the Macintosh, both TaxTron editions are provided in multiple jurisdiction versions to enable filing where 
taxes are due to more than one province. At this time, this option is not yet enabled in Windows.

For Corporate returns, T2 and AT1:

TaxTron Mini Macintosh, for small corporations and limited return capability.
TaxTron Limited Edition Macintosh, no multiple jurisdiction but full tax return capabil-

ity.
TaxTron Corporate Macintosh and Windows, for all corporations except banks, and 

insurance corporations.

All corporate products prepare federal returns for all provinces, and the provincial AT1 for Alberta resident 
corporations. Quebec CO-17 capability is not provided at this time. Our T2 products are updated twice a year 
consistent with revisions introduced by CRA.

Note: The software described in this guide is our current Windows product, Professional edition.

Our Corporate and Macintosh products will conform to the features and functionality described here but not 
at the current time.

mailto://support@taxtron.ca
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Getting Started

TaxTron System Requirements

Microsoft Windows Platform:
•	 Windows XP, Windows 2000, Windows Vista Home Basic/Home Premium/Ultimate (32 or 64 bit), Win-

dows 7 Home Premium/Professional/Ultimate (32 or 64 bit),
•	 512 Megabytes of dedicated System RAM
•	 Intel Pentium 4, 1 GHz or faster compatible processor
•	 1024 x 768 screen resolution or greater
•	 100 MB of free Hard Drive space (not including saved tax return files)
•	 Microsoft .NET Framework version 2 or higher required (built in to Vista and Windows 7, Windows XP 

and Windows 2000 users must install separately)
•	 Connection to the Internet including dial-up.

Macintosh:
•	 OS X 10.4.11 and later.
•	 Installation uses about 70Mb of space.
•	 Connection to the Internet including dial-up.

Installing TaxTron

Windows

Launch the TaxTron Installer and follow its instructions. By default TaxTron will be installed in the Programs di-
rectory. If you want to install it somewhere else, choose to do so when prompted.

When installation is complete, a short cut will be placed on your desktop, and you can ask the installer to launch 
the program directly.

Managing TaxTron Files

Each TaxTron return can be saved as a file containing the data of a single return (two in the case of a linked re-
turn). The extension of these files identify the program and year for which they were created and saved. Thus 
the extension T10 a T1 file of a 2010 return. Corporate returns use the extension Cxx, where C identifies the 
return as a corporate return.

When you create an electronic copy of your return for NetFile, a different, separate file is created. The extension 
of a file for NetFile purposes is .TAX, .EOL or .XML depending on how the file was created. The extension XML 
will replace use of .TAX and .EOL for 2011 returns and later. You can choose where you will save your files. By 
default TaxTron proposes:

 My Documents\TaxTron\TaxPilot\yyyy\

Where yyyy is the year of the returns. Within this directory, separate directories are maintained for your tax 
return files (T10), federal NetFile files (DotTAX), Quebec NetFile files (MRQFile), professional EOL files (EFile), and 
any pdf print files you have generated of your returns (PDF).

Using Online Help

Help is available online to enable you to get the best usage of TaxTron. The Help menu provides access to the 
help, as well as use of the F1 key. Help provides information on the usage of the product, guidance on comple-
tion of a tax return and information on the government’s tax regulations.
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TaxTron Reference

Launching TaxTron

The installation provides a short cut on the desktop. Double clicking this will launch the program. The first time 
you launch TaxTron, you will be presented with the following window:

There are three active panes in this window:

Recent Returns Shows a list of recently active returns, empty on first starting.
TaxTron Channel Presents a portal to the TaxTron web site.
Changer la langue / Switch 
Language

Provides a rapid way of changing the language of presentation be-
tween English and French.

At the foot of the Recent Returns pane, are three short cut action buttons: Create New Return, Open Existing 
Return, and Roll Forward Previous Year’s Return.

Clicking on Create New Return will enable you to start work with TaxTron.

If your PC is connected to the internet, then clicking on the Welcome buttons in the TaxTron Channel will pres-
ent further pages from our web site.

Underneath the TaxTron Channel pane, there is a tab-bar geared to tax professionals. It has additional options 
to allow them to view and print lists of their prepared returns, check the status of the returns and can also send 
returns through CRA’s EOLPlus service.

What is a TaxTron Return

A TaxTron return is a collection of tax forms that constitute your return. The collection of forms is just that set 
of pages required to meet the conditions of your return. TaxTron includes all the forms re- quired to model the 
most complex of Canadian returns.
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TaxTron provides several different ways of looking at your return. It also provides ways of adding forms and 
deleting forms to and from your return as your tax situation changes based on the responses you give and your 
elections as you prepare it.

Each return is a separate item that you can work on, save, re-open subsequently, print and prepare the elec-
tronic copy for filing over the internet. When saved, each return is a separate file on your hard disk, that you can 
use in any of the ways that Windows Explorer allows.

Application modes

TaxTron provides two ways of looking at the content of your returns: Steps mode and Forms mode. Once a re-
turn is open, you can use either Steps mode, Forms mode, or a combination of the two.

Note: Steps mode is not available in the Corporate products.

Steps Mode

In Steps mode we provide a guided process for the completion of your return. Through the presentation of a 
defined sequence of panels, the data necessary to complete your return is solicited. When you follow the se-
quence from beginning to end, your return will be complete and ready to be filed.

You can enter Steps mode, using the “Steps mode” command in the View menu, choosing “Steps Mode” in the 
mode tool in the tool bar, or switching into Steps mode by clicking in its window.

The first Steps mode window looks like this:

The tabs along the top indicate the major steps you will take in preparing your tax return.

You will begin in the Identification section, and then based on your responses, proceed through the Income, 
RRSPs, Deductions, Provincials, Review and Print & File steps.

Once you have been through the steps, under our guidance, you can then jump back to steps you have com-
pleted, and forward as you wish.
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The arrows in the lower right corner, enable you to proceed through the steps. You can only leave a screen 
when you have completed the entries satisfactorily. For instance, without clicking on either Yes or No in this first 
screen, the forward arrow will not allow you to proceed.

You can resize the Step mode pane, and all the active buttons remain visible.

Forms Mode

In Forms mode we provide you with a presentation sequence of your own choice. You are able to select at 
random which forms you look at, which forms you enter data into, and which forms you add or delete to and 
from your return.

You can enter Form mode, using the “Form mode” command in the View menu, choosing “Form Mode” in the 
mode tool in the tool bar, or switching into Form mode by clicking in its window.

The first Form mode window may look like this (it will vary depending on the province of the return, and will 
differ on reopening a return):

In this view, the window contains one form of the tax return. The tabs at the top of the window, name the forms, 
and, once several forms are displayed, provide a means of selecting a form. The highlighted tab indicates which 
page is currently selected and displayed.

The vertical tabs, StartUp and John, enable access to the StartUp screen, and provide a quick return to the tax 
return for “John”.

The scroll bar on the right, enables scrolling through the contents of the selected form.

The button, “Toggle View”, appears whenever a form contains several pages. In Untoggled view, you can scroll 
through all pages using the scroll bar. In toggled view, additional tabs are provided that allow jumping directly 
to a specific page of the form. Scrolling is then through that one page on its own.
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The difference between the display of a form, toggled and untoggled is:

The additional vertical tabs identify the pages of the form, the currently selected page is indicated by the high-
lighting, and clicking on a tab enables direct access to the content of that page without scrolling.

Moving around a return

Whenever a return is open, and selected, three additional floating/dockable windows are provided:

Summary provides a numerical summary of the tax return,
Open Returns lists the currently open returns, and
Form Manager lists all the forms available for the current return.

Each of these windows is separately floatable and dockable and may be presented as follows:

This shows all three windows docked together. The dotted line separators can be used 
to change the depth of each 
window: just click, hold and 
drag to the depth you re-
quire.

Dragging any one window 
by its title bar, will move that 
window from being docked 
to being floatable, and it can 
be positioned anywhere on 
screen.

The reveal triangle in the title 
bar (or with a right click when 
pointing at any one of the ti-
tle bars), shows a dock menu 
that can be used to alter the 
positioning of the three float-
able/dockable windows:

Untoggled View Toggled View
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In this menu:

Floating Use to change the status of a window from 
docked to floating. Once floated, the title bar 
can be dragged anywhere on screen.

Dockable Use to change the status of the window to 
dockable. Once dockable, and then dragged, 
other icons appear on screen, onto which the 
window can be dropped to declare its docked 
postion.

Auto-Hide Equivalent to clicking on the pin icon.
Dock To short cut command to declare location of 

the window when docked.

The “pin” icon can be used to hide the window. When hidden in this way, 
a new tab bar will be presented:

Floating the mouse over the individual tab buttons will reveal the full 
window.

Clicking again on the pin icon will restore its dock status.

The default is to dock the windows on the left hand side. However, all 
three windows can be “docked” to any one of the four sides. When hid-
den (“pinned”), the tab bar will appear on that side of the window to 
which they are docked.

Summary Window

Position this window and watch as your refund or balance due changes while you complete your return.

Open Returns Window

Listed in this window will be all currently open returns. The format uses a reveal button to show all forms cur-
rently part of the return. Clicking on a form will present that form in the Forms mode window, and will switch 
the display to that form.

You can browse the contents of your return in this way, checking 
into what pages are in your return, and looking at the forms as you 
wish.

Form Manager

The form manager lists all forms that may be part of your current 
return. Forms are assembled in the Form Manager according to the 
province of your return, so that not all forms present in TaxTron will 
be revealed at any one time; just those that are relevant in the cur-
rent context.

(This picture of the Form Manager shows all three of the float- ing 
windows “pinned together”. Clicking on any of the tabs at the bot-
tom reveals that window.)

Each form that is available for inclusion in a tax return is shown as a 
line in the form manager. Each form is identified by status, jurisdic-
tion, name and category:

Pinned Window Panes
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Status When a check mark shows in this column, the form is included in the current return.
Jurisdiction The icon shows whether the form is a federal form, or appropriate to a specific prov-

ince using the flag of that province or territory.
Name Is the abbreviated name adopted by TaxTron to identify the form.
Category Our classification of the form.

Clicking in the title bar of the Forms Manager, provides a sort of the forms in alphabetical order. Clicking again, 
changes the sort order from ascending to descending or vice versa.

You can choose to limit the forms displayed in the Forms Manager by clicking on the tabs at the foot its window, 
Federal, Provincial or All. When Federal or Provincial are selected, just that subset of forms are shown.

Double clicking on an entry in the Form manager, adds that form to the current return, and includes it in the 
set of forms shown in the tabs in Forms mode, e.g. following the addition of the T4 to the return, it shows in the 
tabs:

When a form is added to the return, that can be included several times, such as the T4, then a second set of tabs 
is displayed. In this example, a second T4 has already been added to the return by clicking on the “Add Item” 
button. The 2 instances of the T4 are shown as “T4-1” and “T4-2.”

If it is desired to delete one of these instances, then with it selected, a click on “Remove Item” will delete it from 
the return. You will be asked to confirm your wish to delete the copy.

If it is desired to delete all copies of a form, and the form is an optional form, then the button in the tool bar 
may be used, “Remove Form.” You will be asked to confirm your wish to delete the form, since any data in the 
form will be lost on its deletion.

Entering Data

Data is entered in the currently selected element on a page. A data entry cursor is presented identifying the 
location of the currently active cell.

When a page is first presented, a default data entry cursor is provided. You can move this selection by use of the 
tab key (shift tab to reverse the movement on the page) and by mouse clicking as ap- propriate.

There are usually many data entry elements on a page. Fields that may accept your entries are high- lighted 
differently from those that are static or computed.

Data entry fields may either accept keyed data, or mouse clicks. Check boxes or radio buttons will accept mouse 
clicks to alter their status, as well as use of the space bar when the box or button is selected by use of the Tab 
key.

Data entered in active fields is subject to a variety of immediate validation rules:
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•	 Numeric fields: only accept numbers, a decimal point, and a minus sign. If the field has been defined 
as positive only, either a minus sign will not be accepted, or you will be asked to confirm a negative 
value. (For NetFile purposes, some fields may not be reported as negative amounts.) (Note: when 
working in French, the decimal point is a comma, and when in English a period; thousand separators 
are not used.)

•	 Date fields: only accept numbers in a defined date format: yyyy/mm/dd. Invalid dates (prior to about 
1850 and later than the current year) will typically not be accepted.

•	 Alphanumeric fields: text fields will accept most keystrokes from the keyboard including accented 
characters. Depending on the field there may be other editing rules, such as not accepting a comma 
in an address field.

•	 Social insurance number fields: numeric data only is accepted, and the data must conform to valida-
tion rules for social insurance numbers.

•	 Telephone numbers: numeric data consistent with 10-digit north American telephone numbering is 
accepted without response; other numbers (eg European) will be accepted but subject to confirma-
tion.

•	 Postal codes: postal code fields accept data in Canadian format – ANA NAN, validating the first alpha 
character. Other postal codes may be entered but will require confirmation.

In some instances (E.g. entry of an industry code) a popup will be used. Selection from the popup is by mouse 
dragging to the appropriate entry, or by cursor movement key through the list.

Using the Menus

File Menu

New
Creates a new tax return. This command is the 
same as the button in the StartUp Panel, Create 
New Return.

In order to establish a new return you need 
to complete the identification panels, enter-
ing data in the tabs for Taxpayer, Spouse and 
Status. These panels are described in more 
detail in the online help text. When complete, 
clicking OK, will es- tablish the new return, and 
present a window for further data entry.
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An entry for the new return will be found in the Open Returns panel, which will be available there until the 
return is closed. Subsequently you can use this entry to switch to this return.

A tab on the left hand side of the main panel will be added for the new return. When this is the active return, 
the tab will show in bold. The name used in the tab is the first name of the taxpayer. Floating the mouse over 
the tab will reveal the full name and SIN of the taxpayer.

Open
Opens an existing saved return. This command is the same as the button in the StartUp pane, Open Existing Return.

The Open command presents a standard file open dialogue. Navigate through your file system to find a return 
to open. Cancel aborts the open request.

When you choose and open a return, it will be presented in the active window in the same way a new return 
is presented, according to your current view mode, Forms or Steps. The tab will indicate the first name of the 
taxpayer and an entry will be added to the list of open returns in the Open Returns pane.

Roll Forward
Opens a return created using the previous year’s edition of the software and creates a new return for the current year.

 The Roll Forward command presents a standard file open dialogue, in which only those returns cre- ated by the 
previous year’s edition of the software are available to be opened.

Navigate through your file system to find a return to open. Cancel aborts the roll forward request. 

When you choose and open a return, it will be presented in the active window in the same way a new return  
is presented, according to your current view mode, Forms or Steps. The tab will indicate the first name of the 

Identification Window
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taxpayer and an entry will be added to the list of open returns in the Open Returns pane.

Batch Roll Forward
A quick option to roll forward several returns at the same time.

Save
Saves the selected return. If the return has not previously been saved, you will be prompted to name and choose a 
location in which to save it. If the return has not been modified since it was last saved, nothing happens.

Save As
Saves the selected return, always prompting for a new name and location in which to save it.

Save All
Saves all currently open returns, if necessary prompting for a new name and location for returns not previously saved.

Print
Prints the selected return to your selected printer.

Print Preview
Provides a review of the selected return in print format.

Print Current Form
Prints just the current form of the selected return to your selected printer.

Properties
Opens a small window indicating the name, SIN, date of birth and marital status of the taxpayer . Also allows a tax 
professional to record the status regarding EFile and form T1013 for their records.

NetFile (Personal version only)

Prepares the electronic copy of the return for delivery to CRA (Revenue Canada). This option does not appear in the 
Professional version of the software.

MRQ (Personal version only)

Prepares the electronic copy of the return for delivery to MRQ (Quebec). This command is only en- abled when the 
selected return is a Quebec return. Also, this option appears in the Transmission menu in the Professional version.
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Each of the above 6 commands (except Properties) starts in the same sequence:

•	 Verification of CRA return limitation: These commands will only proceed if the CRA return limit has 
not been met.

•	 Requires Activation: If activation has not been completed, then the activation dialogue is presented. 
Unless completed, no further processing is done.

•	 Requires license registration: If required (total income is $30,000 or more) then a license is required. 
The license registration dialogue will be presented.

•	 Proposes to save the return, if not already saved: Cancelling this step will result in the return not 
being saved, and you will not proceed further.

•	 Presents the diagnostics: While errors exist in the return, printing is possible; preparation of the 
electronic version is denied in the personal product.

The Print Return and Print Preview commands then ask for bar code verification. There are a number of exclu-
sions for bar code production, many of which are not determined otherwise. You are asked to confirm that 
none of these conditions exist in your return.

The Print Return command then presents the Print job dialogue. This dialogue is used to identify the returns 
and the set of pages to be printed, number of copies etc. as follows:
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The Return Selection panel allows selection of which of the open returns you wish to print. The default pro-
posed is the currently active return. Click in the left-hand column to choose a return to be printed.

The lower panel, Print Format Selection, provides for the selection of the kind of print-out to be developed. The 
different formats are determined using the Print Format Management command in the Tools menu.

Click in the left hand column to select the format(s) to be used; click in the pdf column to choose to create a pdf 
directly, rather than to print to a real printer; and enter the number of copies to be prepared. If you choose to 
print to a pdf, then the pdf file will be created in the pdf folder as described above.

The Print Preview command presents the Print Preview window as:

In this window you can scroll through your return as it will be printed. Use the number control in the upper 
right to choose which page to view. Use the zoom icon to change the scale of the window. Use the multiple 
page buttons to view up to 6 pages at once. If ready to print, choose the printer icon on the upper left to print 
to your selected printer.

For the electronic version commands (NetFile, MRQ) there are 2 further dialogues:

•	 NetFile validity confirmation: There are various exclusions for NetFile purposes, differing between 
CRA and MRQ. This dialogue asks for confirmation that no exclusions are met in the current return

•	 Connect to CRA or MRQ: When your NetFile version of the return has been prepared you are imme-
diately invited to deliver to CRA or MRQ.

The electronic copy of the return, .tax file or .mrq file, will be placed in the appropriate default folder in the 
TaxTron directory.

Close
Closes the selected return. If the return has not been saved, then it will be saved. If this is the first time it has been saved, 
then the prompt for a name and location will be issued.

Close All
Closes all currently open returns, saving as appropriate, and if necessary prompting for a new name and location for 
returns not previously saved.
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Exit
Ends use of the program. Completes a “Close All” before terminating.

Edit Menu

The Edit menu provides a number of standard editing functions and additional functionality specific to TaxTron.

Cut
Cuts selected text when text is selected.

Copy
Copies selected text when text is selected.

Paste
Pastes at the current cursor position, re-
placing selected text.

Add Schedule
Edit Schedule 
Remove Schedule
Currently inactive, these options are re-
served for future use

Copy Page
The contents of the selected page are cop-
ied to the clipboard.

Paste Page
The contents of the page in the clipboard 
are pasted into the current page, replacing 
the contents of that page.

Clear Page
The contents of the selected page are cleared, replaced with null or zero values.

View Menu

The view menu provides a number of commands that change the view of the current return.



21

Forms Mode
Changes the application mode to 
Forms Mode. The view provided of 
all currently open returns changes to 
Forms mode.

Steps Mode
Changes the application mode to Steps 
Mode. The view provided of all current-
ly open returns changes to Steps mode.

T1 General
Selects and presents for the current return, the pages of the T1 General.

Provincial Return
Selects and presents for the current return, the first page of the provincial return. For Quebec returns this is the TP1; for 
other provinces it is the first page of the appropriate T428.

Link Menu

The Link menu provides commands associated with the 
linked status of returns.

Link Spouse
Establishes a spousal relationship between two returns.

Unlink Spouse
Removes a spousal relationship between two returns.

When creating a return for a married taxpayer, a button prompts to create and link the spousal return at the 
same time. These commands allow this status to be set and reset subsequently, without use of the identifica-
tion command.

Pension Optimization
Computes an optimal split of pensions between two linked spou-
sal returns.

Requires a spousal return to be open with pension income de-
clared.

Tools Menu

The tools menu provides a number of tools for use with your 
returns.
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Review ID Section
Presents the initial dialogues used to create the return for review and modification.

Review Diagnostics
Presents the diagnostics detected in the return, conditions resulting from the structure of the return, or specific data 
entries that should be reviewed and potentially corrected before the return can be filed.

View Overridden Cells
Enables review and verification of data values that have been overridden.

Print Format Management
Provides the means of reviewing the content of each of the several predefined print set contents, and the ability to 
create new print sets.

Preferences
Review and setting of various user 
operational preferences. Note that 
not all options appear in all versions 
of the software.
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File Preferences:
Enables customization of where your Tax-
Tron files will be saved. Initially set to the 
defaults described earlier.

The Password Protection option is cur-
rently disabled and reserved for future 
use.

Auto save specifies the frequency of au-
tomatic saving of your returns, in the ab-
sence of explicit save requests you issue.

Preparer Preferences:
Enables tax professionals to store preferences 
regarding the firm preparing the return.

An essential step for professionals to be 
able to EFILE returns is entering the EFile 
Number and Password provided by CRA.

As well, information provided in this sec-
tion is necessary for the various forms re-
quired to EFiling, such as the T1013, T183 
and RC59.

Discounter Preferences:
Enables tax professionals to store preferences regard-
ing discounting of tax returns, where the taxpayer can 
receive an instant refund for an additional charge.

Note that for the return to be properly discounted, 
you should ensure that the box for “Return is dis-
counted” is checked on the Status tab of the ID sec-
tion of the Taxpayer’s return. The necessary forms 
for discounting the return will then automatically 
be added.

Trustee Preferences:
Enables tax professionals to store preferences 
for trustee information, where the taxpayer 
has gone bankrupt during the tax year and 
the trustee is filing a return on the taxpayer’s 
behalf.

You should ensure that the necessary 
trustee details are entered properly.
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Print Preferences:
Print preferences allows for setting your preferences 
for print operations. Once set, you may continue to 
print according to the defined preferences, or recon-
sider before each print operation as you wish.

You can choose whether to include production of 
the CRA bar code; whether to include a watermark 
on each page; which printer you want to use; and 
whether to include a header or footer for printing 
on every page.

Some of these options may or may not be avail-
able depending on the kind of printout you are 
preparing, eg. the bar code may be declared 
as a required component in a production re-
lease of the software.

General Preferences:
You can use the general preferences panel to 
determine your personalized colour choices 
for the presentation of various components 
of the TaxTron software; choose the lan-
guage in which you want to operate; as well 
as make your selection of other display op-
tions.

Quebec Preferences:
The Quebec preferences stores information neces-
sary for tax professionals to file Quebec provincial 
returns, including the Quebec Preparer Number 
and Quebec Access Codes. It also stores necessary 
details for the MR69 and TP1000 forms required for 
Quebec filing.

Bill Preferences:
This preferences option, new for 2010, allows tax 
professionals to set standardized rates for charg-
ing customers based on the complexity of the tax 
return.

For example, each return may have a certain amount 
of overhead cost for preparing, but certain forms 
which add a great deal of complexity to the return 
can also be charged to the taxpayer on a per form 
basis.

The final cost is tabulated on the Custom Invoice 
form in Taxtron.
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RRSP Calculator
Provides a rapid calculation of potential RRSP contribution benefits.

Calculator
An easy access calculator. Results can be copied and pasted into your returns.

License usage
Shows the status of your license consumption, against your CRA limit.

Transmission Menu (Professional version only)

Provides an interface (similar to the tab-bar on the 
Welcome Pane) that allows tax professionals to EFILE returns 
electronically.

EFile
Sends the currently selected return to CRA via their EFILE service 
for tax professionals.

The EFile option uses the following sequence:

•	 Proposes to save the return, if not already saved: Cancelling this step will result in the return not 
being saved, and you will not proceed further.

•	 Presents the diagnostics: While errors exist in the return, printing is possible; preparation of the 
electronic version is denied in the personal product.

•	 EFILE validity confirmation: There are various exclusions for EFILE purposes. This dialogue asks for 
confirmation that no exclusions are met in the current return

•	 Connect to CRA: When your EFILE version of the return has been prepared you are immediately in-
vited to deliver to CRA.

The electronic copy of the return, .tax file, will be placed in the appropriate default folder in the TaxTron direc-
tory.

SEND
Sends a request to the System for Electronic Notification of Debt for the taxpayer indicated by the currently selected 
return.

Note: Prior to conducting SEND requests, your client must have read, signed and dated a current version of the 
Form T1153, Consent and Request Form. You must keep the original copy of the T1153 form on file for three 
years after the end of the taxation year in which it was signed. It must be kept on file even if you did not dis-
count the taxpayer’s return.

Acknowledgement
Allows you to confirm that a return sent by Efile was properly sent, received by CRA, and accepted.
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EOLPlus Reports
Allows you to receive a report detailing files sent by EOLPlus. Essentially the EOLPLus equivalent of Acknowledgement.

MRQ (Professional version only)

Prepares the electronic copy of the return for delivery to MRQ (Quebec). This command is only enabled when the se-
lected return is a Quebec return. Also, this option appears in the File menu in the Personal version.

The MRQ option uses the following sequence:

•	 Proposes to save the return, if not already saved: Cancelling this step will result in the return not 
being saved, and you will not proceed further.

•	 Presents the diagnostics: While errors exist in the return, printing is possible; preparation of the 
electronic version is denied in the personal product.

•	 MRQ validity confirmation: There are various exclusions for MRQ purposes, differing from those 
used by CRA. This dialogue asks for confirmation that no exclusions are met in the current return

•	 Connect to MRQ: When your EFILE version of the return has been prepared you are immediately 
invited to deliver to MRQ.

The electronic copy of the return, .mrq file, will be placed in the appropriate default folder in the TaxTron direc-
tory.

EFile/SEND Info
Allows you to get detailed information regarding a return rejected by CRA or details regarding the SEND response for 
the selected taxpayer.

If requesting EFile Info, the information presented will include an EFile er-
ror code and detailed description of the error and how to fix it. If request-
ing SEND info, the information presented will include the SEND response 
code and an explanation of the response code.

History
This opens a browser window to CRA which will automatically log you in 
to the EFILE site (using the Preparer in-
formation provided in Preferences) and 
show your EFILE Transmission History, all 
without requiring you to manually log in 
and navigate to the page.

Help Menu

Provides access to the online Help tool 
in TaxTron. 

Contents
Presents the window shown right.
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Index
Presents the index into online Help, equivalent to clicking on the Index tab in the above window.

Search
Presents the Search pane of the Help material, equivalent to clicking on the Search tab in the above window.

About…
Provides version and related publication information.

Using the Toolbar

The tool bar may vary depending on the state of the return that is selected, but typically will look like the fol-
lowing:

Each icon in the toolbar provides a short cut access to a function of the program. When floating the mouse 
pointer over each icon, a tool tip is provided indicating which function will be invoked when the tool bar icon 
is clicked.



28

Appendices

Keyboard Shortcuts

Other keystrokes:

Alt + F4 Close
Ctrl + Del Clear Page
F1 Help

Letter + Ctrl + Ctrl + Shift

A Add schedule
B
C Copy Copy Page
D
E Edit Schedule
F NetFile Forms mode
G
H
I Review ID
J
K Calculator
L
M Remove Schedule
N New
O Open
P Print Print Current Form
Q
R Show Diagnostics Roll Forward
S Save Save All
T Steps Mode
U
V Paste Paste Page
X Cut
Y
Z
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TaxTron Software license / Warranty
The following warranty and license is presented during installation. It is required to be accepted before the 
installation will proceed.

Before INSTALLING the package containing TAXTRON software, please carefully read this Agreement, 
which contains the terms under which you (“Licensee”) are acquiring a license to use the accompanying 
TAXTRON software. If Licensee does not accept the terms of this Agreement, please do not INSTALL the 
accompanying software, promptly return the program for a full refund of any license fees paid. If Li-
censee INSTALLS the accompanying software, or uses it, Licensee will be acquiring a license to use TAX-
TRON software product in object code form, including any related printed or electronic documentation 
(COLLECTIVELY CALLED THE “PROGRAM”), ONLY IN ACCORDANCE WITH THE TERMS OF THIS AGREE-
MENT, AND LICENSEE WILL BE CONSIDERED TO HAVE ACCEPTED AND AGREED TO THE TERMS OF THIS 
AGREEMENT.

1 Grant of License
(a) In consideration of the payment of the license fee for the Program, subject to the terms of this 

Agreement, TaxTron grants to Licensee a non-exclusive, nontransferable, limited and restricted li-
cense as follows:

(i) to install and use the Program on Workstations for Licensee’s own personal purposes;

(ii) to make additional copies of the Program in machine readable form provided Licensee in-
cludes any and all TaxTron copyright notices or other designations that appear or may appear 
in or on the Program, without alteration or removal of any such copyright or other notice on 
the original copy of the Program.

(iii) to produce up to twenty (20) tax returns for filing with CCRA per the application specifica-
tions.

2 Exclusions
Except as expressly authorized under this Agreement, Licensee is prohibited from doing any of the following 
things to the fullest extent permitted by law:

(a) sublease, lease, license, re-license or grant other rights in the Program;

(b) provide use of the Program in a computer service business, third party outsourcing facility or ser-
vice, service bureau arrangement, network, concurrent use arrangement, time sharing or interactive 
cable television arrangement to users who are not properly licensed by TaxTron;

(c) translate, reverse engineer, modify, adapt, create derivative works, decompile, merge, separate or 
disassemble any part of the Program;

3 Ownership
The Program is licensed, not sold. All intellectual property rights, including all copyrights and patent rights, in 
and to the Program shall, at all times, remain with TaxTron or its licensors. Licensee shall acquire no right what-
soever to all or any part of the Program except the right to use the Program

in accordance with the terms of this Agreement and TaxTron and its licensors reserve all rights not expressly 
granted to Licensee. Physical copies of the Program remain the property of TaxTron. Licensee must fully repro-
duce any copyright or other notice marked on any part of the Program on all authorized copies and must not 
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alter or remove any such copyright or other notice.

4 Limited Warranty
TaxTron does not warrant that the functions of the software will meet your requirements, or that the software 
will operate error-free or uninterrupted. TaxTron has used reasonable efforts to minimize defects or errors in the 
software. You assume the risk of any and all damage or loss from use or inability to use the software. TaxTron 
makes no other warranties, expressed or implied, statutory or otherwise, with respect to the documentation or 
the software described in the documentation. In no event shall TaxTron be liable for direct or indirect, incidental 
or consequential damages resulting from any defect in the software.

5 Limitation of Liability
THE ENTIRE RISK, AS TO THE RESULTS AND PERFORMANCE OF THE PROGRAM, IS ASSUMED BY LICENSEE. Tax-
Tron will perform substantially in accordance with the published specifications, the documentation and autho-
rized advertising. Where discrepancies or errors are found or brought to our attention we will provide updates 
within a reasonable period of time that will be available by download for use with or for preparation of existing 
returns.

6 Term
Subject to the terms and conditions of this Agreement, the license granted under this Agreement shall remain 
in effect until Licensee ceases all use of the Program and provides written notice to TaxTron of same. TaxTron 
may terminate this Agreement due to Licensee’s failure to comply with any of the pro- visions of this Agreement 
if after thirty (30) days written notice of such failure remains uncured. Upon termination by Licensee or TaxTron, 
Licensee agrees to promptly purge all copies of the Program from all computer systems on which it was stored.

7 Governing Law
This Agreement shall be governed by the laws of the Province of Ontario, Canada. Each party hereby agrees to 
comply with all applicable laws, regulations and government orders in performing its obliga- tions under this 
Agreement.

8 Entire Agreement
This Agreement is the entire agreement between the parties with respect to its subject matter and supersedes 
and replaces all prior oral or written agreements, representations, negotiations or understandings between the 
parties relating to such subject matter. No change or modification to this Agreement shall be valid unless it is 
in writing and signed by a representative of both parties. No provisions in any purchase orders, or in any other 
documentation employed by or on behalf of Licensee in connection this Agreement, regardless of the date of 
such documentation, will affect the terms of this Agreement, even if such document is accepted by TaxTron, 
with such provisions being deemed deleted.

9 Waiver
No party will be deemed to have waived the exercise of any right that it holds under this Agreement unless 
such waiver is made in writing. Failure or delay by either party to exercise any of its rights, powers or remedies 
hereunder shall not constitute a waiver of those rights, powers or remedies. The single or partial exercise of a 
right, power or remedy shall not prevent its subsequent exercise or the exercise of any other right, power or 
remedy.
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10 Indemnity
Licensee agrees to indemnify and hold TaxTron and its licensors, including their respective affiliates, subsidiar-
ies, officers, directors, employees, agents, or representatives, harmless against any and all third party proceed-
ings, causes of action, suits, damages, losses, liabilities, costs and expenses (in- cluding legal fees) whatsoever 
that may arise, either directly or indirectly, in any connection with any act or omission on the part of Licensee, 
or its use of the Program.

11 Language
The original of this Agreement has been written in English and Licensee waives any right it may have under the 
laws of Licensee’s territory to have this Agreement written in any other language. Licensee represents that it 
has the ability to read and write in English and has read and understood this Agree- ment. All communications 
between the parties hereunder shall be in English. Les parties aux présen- tes ont exigé que cette entente et 
tous autres documents envisagés par les présentes soient rédigés en anglais.
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